
You can use it on fields 

and documents. It lets 

you analyze and modify 

databases. You can use it to work with 

several documents simultaneously. 

With over a hundred powerful tools, 

scanEZ is like a full‑service garage for 

your Lotus Notes databases.

To begin exploring scanEZ's features, select a database to 
work with on your Lotus Notes Workspace, then click the 

scanEZ icon in the Ytria Toolbar. 

You can select notes (ie documents, design elements, deletion 
stubs, etc) or categories of notes by clicking on their names 
in the Selection Tree pane, which is on the left-hand side of 
the main scanEZ window. The right-hand pane in scanEZ is 
contextual—it changes based on what is highlighted in the 
Selection Tree.

The scanEZ 
Selection Tree

The Item List panel

The Note Info panel

The main scanEZ screen 

The resizable, editable 
main scanEZ screen 
vs. the tiny read-only 
Document Properties 
window in Notes.

The Lotus Notes Document Properties window

QuIck ST rT
g u i d e

Note: In scanEZ, checkbox 
selections work independent 
of highlighted selections. 
Think of checkbox selections 
as ‘sticky’ selections that can 
be non-contiguous. Only 
the commands found in the 
Checkbox Selection menu/

contextual menu will affect checkbox selections. 

!
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2
Ytria scanEZ makes viewing and editing 
document‑level information a snap. 
Here's how:

2.1 Explore the Note Info tab: When a document 
is selected this tab (in the lower-right pane in scanEZ) shows 
you all the information you'd see in the Document IDs and 
Document Info tabs of the Lotus Notes Document Properties 
window. Unlike Notes, scanEZ lets you copy this information 
to the clipboard.

2.2 Readers/Authors: This tab gives you a quick 
rundown, by name, of any readers and authors associated 
with a document.

2.3 Keep track of family ties with Parent/
Response tabs: If the document has any responses or is  
a response to another document, Parent and or Response 
tabs will appear. If the document is a response, a 
convenient Go to Parent button will appear in the tab.

1
Ytria scanEZ gives you far better 
access to field information than Notes 
and Domino. You can use scanEZ to 

easily manipulate field data in documents. 
Here's how:

1.1 Open documents from the Selection Tree: 
Simply select a document from the Selection Tree (you 
could also select a document directly from your Lotus Notes 
client and click the scanEZ icon in the Ytria toolbar). 

1.2 See all the fields contained in a document 
at the same time: The right-hand side of the scanEZ 
window should now show the Item List panel on top  
(which shows the document's fields) and the Note Info 
panel below. Notice how much easier it is to read 
document information here compared to the Document 
Properties window in Notes.

1.3 Sort, filter or group field information: Just 
click any of the column headers to sort items or click on the 
filter icon to further sort the information. You can also drag 
column headers to the grouping area at the top of the 
window to group by those criteria.

1.3a click the column header  
to sort items

1.3b click the filter icon for 
more sorting options

2.1 The scanEZ Note Info tab

1.3c Group by column headers

2.2 The scanEZ readers/Authors tab

1.4 Quick or advanced field searches: When you 
have a document item selected in scanEZ's Item List panel 
just start typing and a search window will appear—just like 
in a Notes view. You can also click Ctrl + F for advanced field 
searches with regular expression support.

1.5 Modify, delete or create fields: Just click on a 
document field or item to enable editing; right-click in the 
document's window for options that let you Delete a field 
or Create a new one.
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2.4 Deleting without creating deletions stubs: 
Whenever you delete a document in scanEZ, you have 
the option of not creating a deletion stub.

2.5 Even more 
options in the Document 
Menu: This menu offers a 
number of other options that 
help you work with 
documents.

3
For a ‘view on the fly’ you can use 
scanEZ's MySelection virtual folders 
and title options. Here's how:

3.1 Put just about anything inside a virtual 
folder: MySelection virtual folders let you collect database 
contents together in a sort of ‘view on the fly.’ There are a 
few different ways to add documents or other notes to 
MySelection folders:

A]  For individual notes or whole categories you can right 
click to add to a MySelection folder.

B]  You can use checkboxes to make non-contiguous 
selections, then click Add to New MySelection in the 
Checkbox Selection menu/contextual menu. 

C]  Many dialogs in scanEZ (including those in all the 
Search menu options) allow you to add documents to 
MySelection folders.

3.2 Title Options to give meaningful names to 
your data: One of scanEZ's most useful features is the 
ability to customize titles used in MySelection folders and 
elsewhere in the Selection Tree. To change titles, you can 
either: a) select a field in an open document then click the 
Use Field as Title button or b) click the Change Displayed 
Title button and use any of the options listed below.

3.2.1 Default: This option will use predefined for titles 
(eg Form field for Documents, Type for Designs, etc).

3.2.2 Field Name: This lets you choose a field whose 
values will be used for titles.

3.2.3 Formula: With this option, you can enter a 
formula to generate titles. Formulas here can do things 
that view selection formulas can’t (eg you can use  
@getdocfield and @dblookup commands).

3.2.4 Column Value: Choose a view or folder column 
and use its values for titles.

Note: IBM Lotus Domino Help defines a Deletion 
Stub as: “A truncated document that is left in a 

database in place of the original document to indicate 
to the Replication task that the document should, in 
fact, be deleted from all other replicas.”

!

Note: You can create as many MySelection virtual 
folders as you like. 

!

3.1.B A checkbox 
selection in scanEZ 3.2 changing 

Selection Tree 
titles
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3.3 Do things your way with custom 
re‑categorization for MySelection folders: You can 
also choose how to organize notes in your MySelection by 
right-clicking the virtual folder and choosing ‘Re‑categorize.’ 
Here are the available options:

3.3.1 Using Current Displayed Title: This option 
will categorize the notes inside your MySelection by 
whatever settings you are using for displayed titles.

3.3.2 Flat: This option will remove all categorization 
and display the notes flat.

3.3.3 Default: This option will categorize notes using 
scanEZ's predefined defaults (eg Form for Documents, 
Type for Designs etc).

3.3.4 Field Name: This lets you choose a field whose 
values will be used for categories.

3.3.5 Formula: This allows you to categorize notes 
with a formula (eg entering “@Lowercase(subject)” will 
re-categorize the MySelection folder using the Subject 
field value in lowercase).

3.3.6 Column Value: This option lets you categorize 
the notes in a MySelection folder by a view or folder 
column value.

3.4 Home in on your target with advanced 
Selection options: Once notes are in collected in 
MySelection folders, scanEZ offers the following right-click 
(and Checkbox Selection menu) options to narrow down 
your selections:

3.4.1 Select All with Identical Displayed Title: 
This is a handy feature to use in conjunction with the 
title-changing options. The dialog gives the option of 
skipping the first match or conversely selecting only  
the first match.

3.4.2 Select Using Regular Expression: You can 
also use regular expressions (regexes) to grab extremely 
specific selections. 

3.5 More options for managing virtual folders 
in the MySelection menu:

3.5.1 Rename Selection: This lets you set a new 
name for a MySelection folder. 

3.5.2 Remove Selection: This lets you delete a 
MySelection folder. Since it is a virtual folder, the 
contents will not be deleted or otherwise affected.

3.5.3 Set as Current Selection: If you have multiple 
virtual folders, this option will let you choose the current 
or active MySelection. 

3.5.4 Remove from Selection: This lets you remove 
checked items from a MySelection folder.

4
You can use scanEZ for database 
analysis and modification. Here's how:

 
4.1 View and edit all your Documents, Profile 

Documents and deletion stubs: Unlike the Lotus Notes 
client, scanEZ lets you see Profile Documents—you'll find 
them in the Selection Tree. You can also create a new 
Profile Document by clicking the button pictured below.

4.2 The Conflict Solver: This lets you quickly analyze 
and fix conflicts in your databases. Using the Conflict Solver 
is simple: just select one-or-more conflicts in the Selection 
Tree and click the Conflict Solver button (   ). 
From here you can look at the fields of each version of the 
document in a table and then decide which value to keep.

4.2 choose what should stay 
and what should go with the 
scanEZ conflict Solver

Ytria scanEZ puts 
conflicts in plain sight.
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6
There are tons of other great features 
in scanEZ. Here are just a few more:

6.1 Explore the top‑level of a database: If you 
click the database icon at the top of the Selection Tree (this 
icon takes the name of the open database, so in the 
example screenshots it will be called “The Library”—the 
name of the demo database used) scanEZ will give some 
general information about your database.

6.2 The Document Comparator: This feature lets 
you see all the contents of multiple documents side-by-side 
in a sortable table. There's no limit to the number of 
documents you can compare. To use the Document 
Comparator, select the documents you'd like to look at with 
a checkbox selection and then click the Compare 
Documents button.

5  You can scan and modify fields for 
multiple documents simultaneously with 
scanEZ's Diff Panel. Here's how:

5.1 The Diff button: This lets you check the 
consistency of several documents' fields and values. Just 
select a collection of documents (ie a folder, a MySelection 
virtual folder or a category of documents) in the Selection 
Tree and click the Diff button to compare and contrast the 
fields in the selection.

5.2 The Values button: If you click this button 
you'll get a spreadsheet-like view of the selected fields (hold 
down the Ctrl key to select non-contiguous items). You can 
choose to use either a Grouping grid (offers extensive 
sorting and filtering options) or a Basic grid (uses less 
memory) to display field values.

5.3 Other Diff Panel options: 

5.3.1 Create: lets you create a new field in all the 
selected documents.

5.3.2 Rename: lets you rename one-or-more fields in all 
documents.

5.3.3 Copy: lets you copy one-or-more fields in all 
documents. 

5.3.4 Modify: lets you change a field value in all 
documents, either manually or with a formula.

5.3.5 Delete: lets you delete one-or-more fields in all 
documents.

6.1 Ytria scanEZ gives you access to database 
level information

Note: It's often very handy to use the Values 
button after you've used the Diff button. By doing 

this you see the difference between documents in 
greater detail. If you'd like to make a non-contiguous 
selection, hold down the Ctrl key while clicking items.

!

Buttons available in scanEZ's Diff Panel

6.3 Ytria scanEZ's Search menu options: 
Results for all search types are placed in My Selection virtual 
folders. Also, you can customize the diplayed titles of any 
results (see section 3).

6.3.1 Search by UNID

6.3.2 Search by NoteID

6.3.3 Search by NoteID Range: For this feature 
you'll be prompted to type the first and the last NoteID of 
the range you'd like to search.

6.3.4 Search Design Element by Title

6.3.5 Search by Formula: Lets you search using  
@Formulas (and save the formulas for future use).

6.3.6 Quick Retrieve Contents of a View or 
Folder: Lets you gather the contents of an existing view 
or folder. Because indexed information is used, this 
option is usually very fast.

6.3.7 Search using Full Text: For Notes-style Full 
Text searches.
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6.4 The Document Analyzer: Reads the contents 
of your database and helps you find specific information or 
anomalies that @formulas cannot.

6.5 The Replication Auditor: It’s like a crystal ball 
that lets you see what's going to happen during the next 
replication (including mishaps like conflicts). You just need 
to click the Audit button to use this feature.

6.6 The Post Replication Auditor: Shows the 
state of a database after a replication. This can give you 
great insight into replication issues including document 
resurrections (ghosts). 

6.7 Database ACL management made easy: 
The ACL icon in the scanEZ Selection Tree shows the same 
information you'd see in Notes. But there is one big 
difference—scanEZ makes it much easier to scrutinize or 
edit your ACLs thanks to its spreadsheet-like grid interface.

6.6 The ghost icon in scanEZ's Post 
replication Auditor flags potential 
resurrections

6.8 Instantly apply changes to your Notes.ini 
file: Just click the INI button in the scanEZ toolbar for access 
to scanEZ's Notes.ini Editor. Any changes will be applied 
instantly—you don't need to restart the Notes client.

6.7 With scanEZ database AcL management is simple  
and intuitive

Note: The Notes.
ini Editor is fully 

functional in the free 
Lite version of scanEZ.

!

6.5 The replication Auditor in scanEZ



1
Ytria aclEZ gives you a bird's eye view of 
server ACLs. Here's how:

1.1 Once you select a server you can see all its 
ACL information: When you first launch aclEZ, you need to 
choose a server in the File menu. Once a server is loaded, the 
Databases pane (on the left) will list all the databases on the 
selected server. Ytria aclEZ will load the ACL information for any 
databases checked in this pane. Here is a quick overview of how 
aclEZ presents this information: 

The main aclEZ window Take complete control 

over al l your Domino 

server ACLs. Ytria aclEZ 

gives you a quick overview of all the 

ACLs on a server, plus it lets you 

mass‑edit settings, manage roles, 

explore groups and more.

The ACL entries pane  
in aclEZ

The Group Expander 
button in aclEZ 
lets you see all the 
members of a group 
in an ACL entry

If you enable the ‘Expand 
Nested Groups’ function 
in the Options menu of 
aclEZ, you'll see all of a 
group's members in the 
ACL Entries pane. Group 
members will have a pink 
background

QuICk ST rT
g u i d e

When you select ACL entries in aclEZ's ACL Entries pane, the database to which they 
belong will be shown in boldface in the Databases panel
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1.1.1 Ytria aclEZ gives you an in-depth overview 
of ACL information: The ACL Entries pane lists all the 
selected databases' ACLs. This pane supports grouping—
just drag a column header to the gray area to sort ACL 
information by any category you wish.

1.1.2 Quickly make changes to Access levels and 
privileges: From the Attributes panel you can make 
mass-modifications to Access level and privileges to 
groups or individuals selected in the ACL Entries pane. 

1.1.2 The aclEZ Attributes panel

1.1.3 See who has what role: The Roles panel lists 
detailed information about all the roles present in the 
databases whose checkboxes you've ticked in the 
Databases panel. If you select one-or-more entries in the 
ACL Entries pane, the Roles panel will tell which names 
have a given role assigned to them through the checkbox 
in the Role Assignment column. If it's checked, the role is 
assigned to the selected names; if unchecked, the role is 
not assigned to the names; if the box is filled-in or 
indeterminate, the role is assigned to one-or-more but 
not all selected names; or if the whole cell is grayed-out, 
the role is not available in the selected names. You can 
click the Role Assignment checkbox to toggle role 
assignment for the selected names. 

Where you have a heterogeneous selection of names, 
the ‘Names Affected’ column shows which names have a 
particular role available in their ACL. 

The right-click menu in the Roles panel lets you define 
new roles (with the ‘New Role’ contextual menu option), 
as well as rename or delete existing roles.

1.1.4 See where an ACL entry is present: The 
ACL Entry Presence Panel will reveal whether selected 
ACL entries are present in any given database. This panel 
supports grouping by dragging column headers. Here is 
an example of how you might put this feature to good 
use: In figure 1.1.4 the selected name in the ACL Entries 
pane is the “Administrators” group, so in the seven 
databases where the Presence is Unchecked there is no 
Administrators group.

1.1.1 Grouping ACL Entries in aclEZ. In this example we 
can see that seven selected databases are set to give 
Manager Access by default

1.1.4 The aclEZ ACL Entry Presence panel

1.1.3 The aclEZ roles panel
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2
With aclEZ you get a quick overview of 
ACL settings; it lets you edit, mass‑edit 
or even copy and paste ACL entries. 

Here's how: 

2.1 See and change all your ACL entries: In the 
ACL Entries pane you can also manually adjust access settings.

2.2 You can create new ACL entries: In the ACL 
Entries pane you can also add new ACL entries by right-clicking 
an entry and selecting New ACL Entry (based on current 
selection) in the contextual menu. A window will appear 
where you can name this new ACL entry (see Figure 2.2). 
The new ACL entry will be created with the same attributes 
as the entry that you originally right-clicked. Whenever you 
use the New ACL Entry option on a multiple selection, aclEZ 
will give the new entry the same attributes as the topmost 
entry in the selection. 

2.3 Ytria aclEZ lets you copy and paste ACL 
entries between databases: If you right-click a name  
in the ACL Entries pane there is a Copy Selected ACL 
Entries to... option in the resulting contextual menu. 
When you click Copy Selected ACL Entries to... 
(Figure 2.3a) aclEZ will copy the selected entries' ACL 
settings and a dialog box (Figure 2.3b) entitled ‘Copy 
Element(s)’ will appear. Use this dialog to choose where 
to copy the ACL entries. Please note that ACL entries with 
the same name can have very different settings so be 
careful to choose the correct entries. 

2.1 In the ACL Entries pane you can scroll to the right to see and modify access settings with checkboxes

2.2 This dialog appears for aclEZ's New 
ACL Entry (based on current selection) 
option

2.3a The ‘Copy Selected ACL Entries 
to’ contextual menu option in aclEZ

2.3b The ‘Copy Elements to’ dialog box 
in aclEZ. This is where you choose the 
databases to which you'll copy ACL settings.

Note: When you modify an agent in agentEZ 
you'll see a pencil icon (  ) but in order for 
the changes to actually be applied to your server you 
must click Ctrl+S or select “Apply Changes” in the 
File menu.

!
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3.3 aclEZ's title bar will remind you if Full Access 
Administration is turned on

3
Plus there's support for Full Access 
Administration, a tool for exploring 
NAB groups, a Global ACL Properties 

viewer and more…� Here are just a few of the 
other features: 

3.1 See advanced ACL information for all 
databases on a server at once: In the Global ACL 
Properties tab you can see all the information you'd find  
in the ‘Advanced’ and ‘Log’ tabs in the Lotus Notes Access 
Control dialog. But unlike Notes, aclEZ lets you see this 
information for many databases at the same time. Just 
select all the databases whose advanced ACL information 
you'd like to see in the Databases pane and the information 
will appear in the Global ACL properties tab, each line 
representing the ACL properties on a database. The 
information in this tab is laid out in an easy-to-read grid. 
You can also right-click one-or-more entries and choose 
Edit Element to modify the Administration Server settings 
for your selection.

3.2 Explore the groups in a Notes Address 
Book: The NAB Group Navigator can be found in aclEZ's 
Tools menu. This feature lets you see all the groups and 
group members on a server's NAB, including nested groups. 
The NAB Group nativator lets you see a server's group 
information in either a ‘Tree’ layout or a grid. 

3.3 Ytria aclEZ supports Full Access 
Administration: Just click Options>Full Access 
Administration to turn on this feature. The aclEZ 
implementation of Full Access in no way circumvents Notes 
security, therefore in order to use Full Access Administration 
in aclEZ (or any of our tools for that matter) you must be 
listed as a Full Access Administrator on the server; this is set 
in Domino Administrator.

The Global ACL Properties panel lets you see advanced 
ACL information and change administration server 
settings.
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Ytria agentEZ lets you see and analyze all 
the agents on your server.� Here's how:

1.1 See any agent—even private agents and 
agents not running today: When you first launch agentEZ, 
you'll be prompted to choose a server. Once a server is loaded, 
the Databases panel (on the left) will list all the databases on 
the selected server. Ytria agentEZ will show the agents for any 
databases checked in this panel. If you click the top-level 
checkbox, only databases with agents will be checked off—
that's a great way to quickly determine which databases have 
agents. You have a number of options to help you narrow 
down your selection and organize agent information: 

1.�1.�1 Choose the type of agents to display: Near the 
top of the Databases panel there is a menu where you can 
specify the type of agents to show in agentEZ. Your options 
are to display: All agents; Scheduled agents only (the default 
setting); “Before new mail arrives” agents only; “After new 
mail arrives” agents only; “All documents are created or 
modified” agents only; or “When Server Starts” agents only. 

Also, there is another pull-down menu in this panel that lets 
you choose between using the Design Collection or Basic 
Search to retreive agents. The Design Collection is faster but 

See all the agents 

on  you r  Dom ino 

server—even those 

that aren't scheduled to run today.� 

Ytria agentEZ lets see the load on your 

server, view agent logs, make mass 

modifications to agents, sign agents 

with your current ID and much more.�

QuIck St rt
g u i d e

the main agentEZ window 

1.�1.�1 choose which 
types of agents to 
display
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the Basic Search option will show private/personal agents. 
(NB: The options in this menu won't affect Databases 
panel checkbox selections after the fact. If you make a 
change in this menu you should re-select checkboxes for 
the databases you'd like to work with).

1.�1.�2 Quickly see detailed, sortable agent 
information: In the large main agentEZ pane (aka Grid 
pane) you have access to a wealth of information about 
the agents contained in the selected databases. This pane 
supports multi-layered grouping so you can sort agent 
information by numerous variables (eg in figure 1.1.2a 
the agents are grouped by Schedule Type and Agent 
Schedule).

1.�1.�3 Customize agent data columns in the grid: 
The Grid Data Composition panel lets you choose which 
columns of agent data to include in the grid. Disabling 
superfluous columns can greatly speed up performance 
when dealing with very large sets of agents. Conversely, 
you can use this panel to display a number of columns 
that are not shown by default (eg ‘Run on Behalf’ of).

1.2 Figure out how much agents are 
contributing to your server load (or if they're 
running at all): Ytria agentEZ lets you know the duration 
of an agent's last runtime via the Last Run Duration column 
in the main agentEZ pane. The Last Run Date column, 
which appears in the same pane, has a button that will 
open an Agent's log, if you need more detailed information. 

1.�2a See detailed agent runtime information in agentEZ

1.�2b For even more information, you can view an 
Agent Log

Note: Because of performance considerations, 
agentEZ does not, by default, automatically load agent 
information. To load the agent information, simply 
make a selection and click Ctrl+L. Alternately you 
can set agentEZ to automatically load detailed agent 
information in the Options menu.

!

1.�1.�2a Sorting by Schedule type and Agent Schedule  
in agentEZ

1.�1.�3 the Grid Data 
composition panel

1.�1.�2b Sorting agents by Enable/Disable status in agentEZ
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2.�1.�4 change agent properties in agentEZ
contextual menu 

options in agentEZ

2
With agentEZ it's simple to modify one 
or more agents.� Here's how:

2.1 Modify agents 
with a click of your 
right mouse button:  
If you right-click a selection 
in agentEZ you have a 
number of options for 
modifying agents. 

2.�1.�1 Delete Agent(s): This contextual menu option 
allows you to delete any agents selected in the main grid. 

2.�1.�2 Enable/Disable: These contextual menu 
options let you enable or disable selected agents. 

2.�1.�3 Change “Run on”: This contextual menu option 
lets you change the server on which an agent will run.

2.�1.�4 Change Generic Properties: This contextual 
menu option lets you change a number of agent properties.

1.�3 the Agent timeline panel

the Agent Selector lets you 
highlight an agent in the grid by 
clicking it in the timeline

Zoom In and Zoom 
Out let you change 
the timeline scale

Here you  
can choose  
a date range

toggle between displaying 
‘scheduled agents only’ or 
‘all agent in grid’

Agent run durations are indicated 
by bars on the timeline

1.3 The Agent Timeline for a visual overview of 
the agent runtimes: See when and how long agents ran 
on your server in the Agent Timeline panel. All the agent 
runtimes are displayed in a Gantt chart, so longer bars 
correspond to longer agent runtimes. The Agent Timeline 
will only show agents displayed in the Grid pane. This 
means that any active filters in the Grid pane will remove 
agents from the timeline. Please note than detailed agent 
information (Ctrl + L) must be loaded in the grid for the 
timeline to appear.

changing the “run on” setting in agentEZ



Quick Start Guide — agentEZ p 4

2.�1.�10 Run on Behalf of: This option lets you 
change the Run on Behalf of setting for any selected 
agents. The dialog lets you either select a name from a 
NAB or find a user in a profile document. The latter 
option is useful for setting Out of Office agents to run on 
behalf of the mail file owner.

2.�1.�11 Rename Agent(s): The option lets you 
enter a new name and alias for the agents selected in  
the grid.

2.2 Use Full Access Administration:  
agentEZ (like all other Ytria tools) supports Full Access 
Administration. To turn it on you simply click Options>Full 
Access Administration. This implementation in no way 
circumvents Notes security, so you must be listed as Full 
Access Administrator in order to use Full Access 
Administration in agentEZ. 

2.�1.�5 Change Runtime Properties: This contextual 
menu option lets you edit one-or-more agents' runtime 
properties.

2.�1.�6 Sign and Save Selected: This contextual 
menu option lets you sign and save an agent with the 
current ID. This is a handy way to fix certain agent 
signature issues.

2.�1.�7 Sign with another ID (with signEZ): This 
contextual menu option lets you sign and save agents 
selected in the grid with another Notes ID. In order to 
use this feature you must have a licensed copy of Ytria 
signEZ installed.

2.�1.�8 Open in Designer: The option lets you open a 
selected agent in Domino designer. 

2.�1.�9 Run Agent on Server: The option lets you run 
a selected agent on the server. This feature generates a 
command and displays it in a dialog box. From the dialog 
box you can click OK to send the command to the 
Domino console or Cancel to dismiss it. 

2.�1.�5 change runtime properties in agentEZ

Note: When you 
modify an agent in 
agentEZ you'll see a 
‘pencil icon’ (  ) but 
in order for the changes 
to actually be applied to 
your server you must click 
Ctrl + S or select “Sign 
and Save all modified”  
in the File menu.

!

2.�1.�9 tell the sever to run selected 
agents using agentEZ

2.�1.�10 the run on Behalf of dialog box

2.�2a Full Access 
Administration  
in agentEZ

2.�2b agentEZ's title bar will remind you if Full Access 
Administration is turned on

2.�1.�7 using signEZ and agentEZ together to sign 
agents with a different ID
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Quick 
Start 
Guide
Get a bird’s-eye-view of global 
database properties on a 
Domino server—fast. 

You can launch databaseEZ from Lotus Notes, Domino Designer, or Domino Administrator with this toolbar.

The Output panel (not shown) displays
logs and errors.

The Property Analyzer grid displays the 
databases with issues or unusual properties. 
(e.g. duplicate Replica IDs)

The Databases panel lists the databases on 
your server; tick checkboxes for the databases 
you wish to show in the main grid.

The main grid shows the databases on 
your server along with their properties.

The Grid Data Composition panel lets you 
choose which NSF properties to show in the 
main grid. 

Ytria databaseEZ lets you 
manage NSF properties with 
greater speed and precision. And 
its troubleshooting tools help 
you quickly find and fix database 
issues on your servers.
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1.1.2

See summarized data immediately or 
load complete information: When you 
first populate the grid, the majority of 
properties will be shown immediately—
these are gathered using summarized 
data. What’s more, the use of summarized 
data lets you see many properties for 
databases to which you have no access.
To show the remaining properties, click 
Ctrl+L or Edit>Load Complete 
Database Information.

1.1.3

Choose the properties to analyze with 
the Grid Data Composition panel: 
Roughly 100 database properties can 
be shown in the main grid, but to make 
things more visually manageable, only 
22 are shown by default. 
The Grid Data Composition panel lets 
you customize the properties shown in 
the grid, just tick the checkboxes then 
click ‘Apply.’ You can also save your 
preferences (or even multiple sets of 
preferences) in this panel.

Analyze global NSF properties 
in a grid: When you launch 
databaseEZ, you’ll be prompted 
to choose a server. Once a 
server is selected, the left-
hand panel (Databases) lets 
you click checkboxes for any 
or all databases to show their 
properties in the main grid. 

1.1.1

Group, sort and filter global database 
properties: In the main grid each 
database is represented as a row and 
each column shows a different NSF 
property.  
This grid interface lets you group by 
column headers or perform sorting /
filtering operations.

1With databaseEZ you can 
see and edit properties 
for all the databases on a 
server. Here’s how:

1.1

1.1.1 Grouping by column headers: This example shows a multi-tiered grouping based on three NSF properties.

1.1.2 Summarized data: Yellow shading indicates properties retrieved using summarized data— they’re shown 
nearly instantly.

1.1.3 The Grid Data Composition panel: Use checkboxes 
to choose the properties to show in the main grid.
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2.1.1

Edit Database Basic Properties: This 
option lets you manage properties that 
correspond with the Basics tab of the 
Database properties dialog in Lotus 
Notes. (e.g. ‘Don’t allow URL open’ and 
‘Disable background agents’).

2.1.2

Edit Database Design Properties:  
This option lets you manage properties 
that correspond with the Database 
Design tab of the Database properties 
dialog in Lotus Notes. (e.g. ‘Show in Open 
Application dialog’ and ‘Template name’).

2.1.3

Edit Database Advanced Properties: 
This option lets you manage properties 
that correspond with the Advanced tab 
of the Database properties dialog in 
Lotus Notes. (e.g. ‘Don’t maintain unread 
marks’ and ‘Allow soft deletions’).

2.1.4

Edit Database Miscellaneous 
Properties: This option lets you manage 
properties related to User Activity and 
Replication Settings. (e.g. ‘Record user 
activity’ and ‘Temporarily disable 
replication’).

Contextual menu options: The 
right-click menu in databaseEZ 
offers numerous options for 
managing database properties 
either individually or en-masse, 
including the following: 

2
With databaseEZ it’s      
simple to mass-modify 
database properties. 
Here’s how:

2.1.5

Edit Replia ID/ Generate Replica 
ID(s): You can right-click any database 
in the grid to change its Replica ID.
You can also right-click multiple selected 
databases and generate new replica IDs 
for them.

2.1.6
Export IND File: This allows you to 
export an IND file with the names of all the 
databases currently selected in the grid.

2.1.7
Open with…aclEZ/agentEZ/
designPropEZ/scanEZ/signEZ: These 
options let you open selected databases 
in other Ytria tools. 

You can mass-edit global NSF proper-
ties, see 2.1.1 to 2.1.4 for more. 

Note: 

Like all Ytria software, databaseEZ is fully 
compliant with Lotus Notes security. You 
must have sufficient access in order to 
make changes to databases.

Note: 

Databases changed in the grid are 
marked with a ‘pencil’ icon. However, 
changes won’t be written to the server 
until you click Server>Apply Changes 
(Ctrl+S ) or Right-Click>Apply 
Changes to Selected. 

Also, some properties require that you 
perform a compact operation after editing 
(i.e. “Don’t Maintain unread marks”; 
“Optimize Document Table Map”; “Quota 
Limit”; “Don’t support specialized 
response hierarchy”; and “Compress 
database design”). If the compact step is 
omitted, changes won’t be applied.

2.1
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2.1.8
Sign/Audit with Another ID (with 
signEZ): This lets you directly sign 
or audit the design elements for any 
selected database. This option requires 
that you also own Ytria signEZ.

2.1.9

Open in Designer/Open in Notes 
Client: These options allow you to open 
selected databases in either the Notes 
client or Domino Designer.

2.1.10

Delete database(s): You can use this 
to delete any databases you have 
selected in the grid.

2.2
Full Access Administration: 
Like all other Ytria tools, 
databaseEZ supports Full Access 
Administration. If you’re listed as 
a Full Access Administrator on the 
server you can enable (or disable) 
this feature by clicking Options>
Full Access Administration.  

The Serverwide Property 
Analyzer: This utility lets you 
find databases with unusual 
or problematic properties; to 
launch it, click Tools>Property 
Analyzer. The following property 
analysis options are available:

3.1

3.1.4

Database has a specific percentage 
of quota remaining (%): This will reveal 
all databases that have reached or 
exceeded a given percentage of their 
size quota.

3.1.5

No data change since n days: Shows 
any databases where document data 
has not changed since before the 
given number of days.

3.1.6

Design changed within last n days: 
Shows database where the design has 
changed within the number of days 
given.

3.1.7

Database has reached a specific 
size: Displays databases that match or 
exceed the size given.

3.1.8

Launch Analyzer on startup of 
databaseEZ: By checking this option 
the Property Analyzer dialog will appear 
each time you open databaseEZ.

3.1.9

Save Settings and Run Analyzer: This 
performs the Property Analyzer scan on 
all databases shown in the grid and also 
saves your settings.

3.1.1

Template name duplicates: This will flag 
any identical template names.

3.1.2

Replica ID duplicates: This will find 
databases that share the same Replica ID.
 

3.1.3

Inherits from a template that does 
not exist: This will reveal databases 
that are set to inherit from a nonexistent 
template.

3.1.10

Save Settings:  Saves property settings 
for the next time you open the Property 
Analyzer.

3.1 The Serverwide Property Analyzer dialog: You can 
scan a Domino server for databases that meet the 
conditions entered here.

3
With databaseEZ you 
can scan a server for 
issues or aberrations, 
here’s how:

Property Analyzer grid results:  
If you click Save Settings and 
Run Analyzer, any databases 
that match the entered criteria 
will appear in the Property 
Analyzer grid at the bottom of 
the databaseEZ window. From 
here you can group, sort or filter 
column headers. You can also 
right-click databases to select 
them in the main grid.

3.2

3.2 The Property Analyzer Results grid: Databases 
found using a Serverwide Property Analyzer scan are 
shown in this grid.

The right-click menu in databaseEZ’s main grid.
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The Property Analyzer grid displays the 
databases with issues or unusual 
properties (e.g. duplicate Replica IDs).

The Databases panel lists the databases on 
your server. Tick checkboxes for the databases 
you wish to show in the main grid.

The main grid shows the databases on your 
server along with their properties.

The Grid Data Composition panel 
lets you choose up to five data-
base properties to show in the
main grid.

QUICKSTART
GUIDE

Manage all facets of 
database replication across 
Domino servers or clusters with 
replicationEZ. 

1

2

3

4

5

6

7

8

Find and analyze all of a 
database’s replicas, 
across all servers.

Find all the replicas for a 
given database. 

Analyze database 
properties across servers.

Spot discrepancies between 
replicas across servers. 

Analyze both database-level
and server-level settings.

Seamlessly integrate 
replicationEZ with other Ytria tools.

Initiate replication without 
opening your server console.

Get a flat, sortable view of 
replication history across servers.

Fig. 2  Main interface replicationEZ 

Fig. 1  Ytria toolbar

The area graphically displays
Replication History, Connection 
Analyzer and Discover Replicas charts.

Start by launching 
replicationEZ from the Ytria 
Toolbar (Fig. 1.) 

Follow this guide to: 
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Get the number of replicas, duplicates, and 
non-replicating databases across multiple 
servers.

Get a global map of 
replication across 
servers.  

The main grid lists ‘Generic Properties’ 
in its leftmost columns and shows parent headers for each available 
server which was loaded in the Databases panel (Fig. 2).

1.1

The Discover Replicas grid and chart.

The Discover Replicas command. 
2.1

Fig. 4  Discover replicas grid

Under the Generic Properties parent header, you have access to the 
following columns: 

Explore the replication 
linkages across servers.

• ’Number of Replicas’ displays a count of the number of replicas among loaded 
servers. These columns may be grouped, sorted or filtered (Fig. 2).

After performing a Discover Replicas scan, the results of the scan are shown in the Discover 
Replicas grid and the Discover Replicas Chart (Fig. 4).

When you launch replicationEZ 
without any database selected 
in your Notes client, you’ll see 
the ‘Choose Servers’ dialog 
where you can select the servers 
which will be available in the 
Databases panel (Fig. 3). 

Once servers have been added 
to the Databases panel, you may 
tick check boxes to load them in 
the main grid (Fig. 2). 

By selecting a database in the main grid, all its replicas on the loaded servers are selected 
as well. If you click Tools>Discover Replicas, replicationEZ will retrieve all replicas on all 
the servers in your environment. It achieves this by scanning the replication history of all 
the selected database and its loaded replicas. For each replication history entry it finds, it 
attempts to access the replication history of all other replicas referred to by the previous 
replication history entries until all existing replicas are found.   

• ‘Do Not Replicate’ indicates if one-or-more of the replicas of the 
database in a given row is set to not replicate. 

• ‘Is Duplicate’ indicates if a duplicate replica exists on a server where 
the actual duplicate replica’s cell will be highlighted in red under its 
server’s header.

Find all the replicas for a given database.2

Find and analyze all of a database’s replicas,1 across all servers.

1.2

1.3

2.2

The Discover Replicas feature is especially useful with a partially loaded database (on a server 
or the local machine) as an entry point (e.g. when replicationEZ is launched from the Ytria 
toolbar with the database already open or selected on the Lotus Notes workspace).

Fig. 3  Choose Servers dialog box
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Add Database properties to main grid.
The Grid Data Composition panel allows you to add up to five database properties 
(e.g . Modified date, DAOS status, Physical size, etc.) and to display them in the main grid 
under each server’s parent header, next to the replica file path.

Analyze and edit properties in the Selected Databases panel. 
Select up to 30 databases in the main grid and see key database property information 
associated with all available replicas in the Selected Databases panel (Fig. 5). 

Each replica is represented by a row in this panel with available properties shown under 
column headers. Additionally, you can edit ‘Replication Properties’, ‘Miscellaneous prop-
erties’ or Replica IDs in this panel via the right-click menu. 

Fig. 5  Selected Databases panel

See database content 
discrepancies across 
replicas.
Select any number of databases in the 
main replicationEZ grid and choose ‘Load 
Note Counters’ in the right-click menu to 
compare the contents of databases across 
replicas (Fig. 6). 

4.1

Fig. 6  Note Counters dialog box

Analyze database properties across servers.3
3.1

Find discrepancies between replicas 4 across servers.

3.2
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Revealing ACL inconsistencies across servers. 
Security and access discrepancies can also be discovered by selecting databases in the main grid 
and choosing ‘Compare ACLs’ in the right-click menu. Results will be shown in the ACL Comparator 
panel (Fig. 8). 

Each property or flag for a given database’s ACL is shown on its own row with column headers for 
each loaded server showing the value or status on each replica. 
A handy ‘Inconsistency found’ column lets you spot ACL entries that differ across replicas.

4.2

Fig. 7  Note Counters panel grid displaying inconsistencies in red

Results of these scans are shown in the Note Counters panel grid (Fig. 7). A special 
‘Inconsistency found’ column provides a handy means for quickly spotting databases 
with discrepancies across replicas (displayed in red highlighting).

The Note Counters dialog lets you specify the types of notes to load (e.g. documents,
designs, deletions stubs, etc.).
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Find agents inconsistencies across replicas.
Select any number of databases in the main grid and choose ‘Compare Agents’ in the right-click menu. 
The Agent Comparator grid will display a separate row entry for each encountered agent’s ‘Enabled’, ‘Run 
on’ and ‘Run on behalf of’ property (Fig. 9).  A column header for each server shows the settings for those 
properties on each replica. An ‘Inconsistency found’ column quickly lets you know of any agent property 
differences across replicas.  

Fig. 9  Agent Comparator panel

Fig. 8  ACL Comparator panel

4.3
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Fig. 10 Replication Settings panel

Easier database-to-database 
Replication analysis.
Find any existing selective replication 
formulas and display them in a grid by 
selecting one or more databases in the main 
grid and then by clicking ‘Load Replication 
Settings’. Any available selective replication 
formulas will be shown in the Replication 
Settings grid (Fig. 10). Each selective 
replication formula is given its own row. You 
can delete selective replication formulas via 
the right-click menu. 

See server connections in a flat 
view or a chart.
Manage Server Connection documents by 
clicking Tools>Connection Analyzer and then 
by choosing a server (the NAB from this server 
is used to discover connection document). Re-
sults are shown in a flat view in the Connection 
Analyzer grid panel (Fig. 11). When you select 
any individual Connections Analyzer row, the 
Connection Analyzer Chart will provide graphi-
cal representation (Fig. 12). 

5.1

Fig. 11 Connection Analyzer Grid

Analyze database-level5 and server-level settings.

5.2
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See more detailed agent information in agentEZ. 
Right-click a selection of databases in the main grid and open them in agentEZ. Note that 
a different instance of the tool will open for each applicable server. You have the option 
of loading the server partially (only load selected databases) or fully.

You must have 
aclEZ, agentEZ, 
databas eEZ, or 
scanEZ installed in 
order to use the 
integration 
features.

NOTE:

Fig. 12 Connection Analyzer Chart panel

Perform in-depth security analysis by opening replicas in aclEZ.
Right-click a selection of databases in the main grid to see the open in aclEZ option for 
more complete ACL management options.

Open selected databases with scanEZ.
Select databases in the main grid and open them in scanEZ 
via the right click menu. You have the option of directly 
opening scanEZ’s ACL panel or Replication Auditor tool. 
Note that each replica of a database will open in a separate 
instance of scanEZ. 

Take database property management further with databaseEZ.
Select any database in the main grid and click ‘Open in databaseEZ’ in the right-click menu. 
You have the option of partially (only the selected databases) or fully loading the server. 

6.1

Seamlessly integrate replicationEZ with other6 Ytria tools.

6.2

6.3

6.4
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Save time with the built-in 
console.
In the course of using replicationEZ, 
you may encounter issues that require 
replicating to fully fix them. In such 
cases, select the databases in question 
in the main grid and choose Console 
Commands in the right-click menu 
(Fig. 13). 

You will have the option of initiating 
a replication, push, pull, or custom 
command. The dialog will be 
preconfigured with your database 
selection. You can adjust any of the 
command parameters.

7.1

Fig. 13  Console Commands dialog

Analyze replication history events in a grouping grid.
Select up to 30 databases in the main grid and choose ‘Load Replication History’ in the 
right-click menu to retrieve replication histories. Each line in the Replication History panel 
represents a replication event (Fig. 14).

See charts on where and when replication
occurred.
To see a graphical representation of a replication history event, just select a row in the 
Replication History grid (or the main grid) and choose Load Replication History chart in the 
right-click menu.

8.1

Fig. 14 Replication History Grid Panel

Be sure not to miss new products updates, 
invaluable tips and tricks, and informative event 

For more information (including tips,
 screenshots, and videos) on 

replicationEZ, please visit

www.ytria.com/replicationEZ

www.ytria.com/newsletterSignup

announcements by signing 
up for our newsletter at

~

Initiate replication without opening your7 server console.
Get a flat, sortable view of8 replication history across servers.

8.2
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Ytria signEZ lets you quickly sign or audit 
signatures for multiple documents.� 
Here's how:

1.1 Choose which design elements to work with: 
Just make a checkbox selection in the Design Elements tab of 
the main signEZ window to choose which design elements 
you'd like to sign or audit.

1.2 Set your options: In the Settings tab of the main 
signEZ window you can choose what you'd like to do with any 
selected design elements. The three Action options are: Sign; 
Clean and Sign (ie sign plus delete the selected design elements' 
$UpdatedBy fields); and Audit.

The Selection Tree in the main signEZ window 

Your Notes signature 

nightmares are over.� 

Ytria signEZ gives you 

complete control over database signing.� 

It allows you to: delegate signatures 

to other users; sign using stored IDs; 

audit signatures; and batch sign multiple 

databases.� And signEZ does all this 

without circumventing Notes security.�

The signEZ Design Elements tab is where you 
select the documents you'd like to work with

1.�2 The signEZ Settings tab 

1.�2.�1 More options: The options in the bottom of the 
Settings tab are contextual, changing depending on which 
Action option is selected above. For a detailed explanation of 
available settings, please see the Ytria Help Database at  
http://www.ytria.com/WebSiteHelp.nsf. 

This button can either be “Sign”, “Clean & Sign” 
or “Audit“ depending on what action setting you 
choose in the Settings tab

QuICk ST rT
g u i d e
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1.3 Choose a signing ID: The Sign Using tab lets 
you choose options related to signature IDs. This tab is 
divided into three sections: Stored ID information; Sign 
using another ID; and Sign using current ID.

1.�3.�1 Stored ID information: From here you can 
store and manage signature ID files. If you click the Store 
a new ID button, you can choose an ID file (you'll be 
prompted to enter its password) and once you click Save 
it will be placed in the current signEZ database (see 2.1 
for more on this database). ID passwords will be 
protected using signEZ's AES‑based encryption algorithm.  

Once you have an ID file stored you can set conditions  
for its use by clicking the Stored ID info button. In the 
Stored ID Information window, you can set who has 
access to a stored ID and in what databases these users 
can sign with this ID.

1.�3.�2 Sign using another ID: From here you can 
select an ID file to use for signatures. You can sign with 
any ID provided you know its password.

1.�3.�3 Sign using current ID: Here you can opt to 
use the currently logged‑in ID for signatures.

1.4 Signing and auditing: Once you've made a 
selection in the Design Elements tab and set the 
parameters to your liking in the Settings and Sign Using 
tabs you're ready to click the Sign, Clean and Sign or Audit 

button (whichever you chose in the Settings tab will 
appear) at the bottom of the main SignEZ window. A 
Signature or Audit Status window will appear after signing 
or auditing. This window offers grouping functionality 
(dragging column headers to sort information) and it also 
offers an Export to File option. When exporting, you can 
choose between HTML and plain text.

1.�4.�1 Remember my settings: If you sign or audit 
any design elements while the Remember my settings 
checkbox is ticked, signEZ will create a document in the 
signEZ database that will save your signature or audit 
settings for future use. 

Note: In signEZ you can sign using another ID and 
open databases in Notes or Designer will not close 

on you (as they would if you switched IDs in Notes). 

!

The signEZ Sign using tab 

1.�3.�1 The signEZ Stored ID Information window allows 
you to delegate design signatures

1.�4 The signEZ Signature 
and Audit Status window 

Note: These saved settings will be the defaults 
for the database currently open in signEZ. If 

the database already has default settings, clicking 
Remember My Settings will overwrite them.

!

The signEZ 
remember my 
settings checkbox 
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2
The signEZ database lets you batch 
sign, analyze signature logs and more.� 
Here's how:

2.1 The signEZ database: This NSF database is 
used as a container for stored ID files, logs (optional) and 
Saved Settings documents, plus it serves as a powerful 
application in its own right. You can access a number of 
signEZ's advanced features through the signEZ database.  
This database is either called YtriaEZSuite.nsf (which you 
should have if you installed signEZ as part of a suite) or 
signEZ.nsf (if you installed signEZ on its own). Whatever .nsf 
file you use, it should be placed on a server if you plan on 
using it to hold delegated stored IDs or logs.

You can have as many signEZ databases as you like (eg it 
may be useful to have separate databases for storing ID files 
and logs, each with different ACL settings), you just need 
to use the ‘Link to Another signEZ Database’ command 
in the signEZ application's Database menu to switch active 
databases.

2.�1.�1 The Saved Settings view: This is the first  
of the two views in the signEZ database. If you checked 
the Remember my settings box, any of the settings used 
for signing or auditing will appear here. You can execute 
one‑or‑more saved signing/auditing operations from this 
view by selecting the documents then clicking the 
Execute (or Execute with Another ID) action bar button.

2.�1.�2 The Logs view: The other view in the signEZ 
database is used to store signature or audit logs if you 
either chose to save logs in the Settings tab in signEZ or 
enable forced logging for delegated signing ID users. 

You don't necessarily need to use a signEZ database 
to store your logs—you can set any database to be the 
log container from the Force Log tab of the Stored ID 
Information dialog—but this view is already there for you 
if you choose a signEZ database.

Note: If you accidentally deleted your signEZ 
database, don't worry: you can download a new 

copy at www.ytria.com. Just click the Downloads link 
and look for signEZ Template.

!

3
And you can extend the power of signEZ with 
LotusScript.� Here's how:

 
3.1 Power-users can craft their own custom signEZ 

solutions: Go to www.ytria.com/WebSiteHelp.nsf for more information.

2.�1.�1 The Saved Settings view in the signEZ database 

2.�1.�1 The Logs view in the signEZ database
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Ytria viewEZ gives you total control over 
view columns.� Here's how: 

1.1 View columns laid out right before your eyes: If 
you make a selection in the main viewEZ screen (all your database's 
views and columns will be listed in the Selection Tree) and click 
the Columns button you'll arrive at the Columns window. 

There are three tabs in the Columns window, and each offers  
a different way of looking at a view's columns: 

1.�1.�1 Columns by Position in View: Each header in this 
tab represents a design element (ie views or folders). Each cell 
represents a view column or folder column. The order in which 
the cells appear corresponds to their position in the view.  
You can drag-and-drop or copy/paste view or folder columns 
between design elements on this screen.

1.�1.�2 Columns by Links to Shared Columns: This tab 
looks very similar to the Columns by Position in View tab 
except it's designed to give a quick overview of where shared 
columns are being used.

The main viewEZ window features the Selection Tree (for selecting 
designs) plus a Filter by Property button (lets you narrow down 
design selections using view and/or folder properties).�

Take complete control 

of your Notes views and 

folders.� Ytria viewEZ 

lets you mass-edit view properties, 

preview any changes and undo what 

you've done.�

Note: If you have more than one instance of viewEZ open, 
you can drag-and-drop view columns between databases.

!

Quick ST rT
g u i d e

1.�1.�1 The viewEZ columns by Position in View tab 1.�1.�2 The viewEZ columns by Link to Shared columns tab
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1.�1.�3 Columns by Properties: From here you can 
see all your columns and folders sorted by their properties 
(eg design element type, font size, column width, etc). 
You can customize this tab to display only the properties 
you wish to see (just select or de-select items under Grid 
Columns in the right-click menu). This tab offers grouping 
functionality (drag the column headers to sort). 
Additionally, you can export the displayed information  
to a text or HTML file with the Export to File command 
which you'll find in viewEZ's Columns menu.

1.2 With viewEZ you can see and edit several 
view columns all at once: 

1.�2.�1 Edit or mass-edit view column properties: 
Just right-click your selection and choose Column 
Properties from the resulting contextual menu. 

1.�2.�2 Compare column formulas: Again, just 
right-click your selection and pick the Column Formula 
option in the contextual menu and a window will appear 
where you can compare and contrast the formulas.

formula search options (found in the Search menu and 
the right-click menu). There are options which allow you 
to perform regular expression searches for strings or fields 
in column formulas plus there's a very handy Analyze 
Column Formulas option. 

Analyze Column Formulas gives a quick overview of 
which view columns share the same formula. When this 
feature is engaged, viewEZ will tag cells with a number; 
cells with numbers that are alike share the same column 
formulas. You can then click Ctrl + T for the Quick Tag 
Select feature which selects all columns with a given 
column formula. 

1.�3.�2 Color coded information: In all three tabs  
in the Columns window, you have a choice of color 
coding schemes for view columns. To cycle between 
color schemes, just click the F‑keys below:

> F5: Shared/Not Shared

> F6: Sort Type 

> F7: Family 

> F8: Hidden/Not Hidden 

> F9: Modified/Not Modified 

1.3 Ytria viewEZ gives you lots of view column 
information in a single glance: 

1.�3.�1 Column formula search options: In both the 
Columns by Position in View or Columns by Link to 
Shared Column tabs you have access to powerful column 

1.�2.�1 Mass-edit view columns in viewEZ 

Note: you can make non-contiguous selections by 
holding down the Ctrl key).

!

1.�2.�2 Ytria viewEZ lets you see selected column formulas 
side-by-side

1.�3.�1 Analyze column formulas in viewEZ

1.�1.�3 The viewEZ columns by Properties tab
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2
Ytria viewEZ gives you the power to 
mass-edit view formulas and 
properties.� Here's how:

2.1 Access to view Properties and the 
Programmer's pane options in a single window—
with mass-editing capabilities: If you make a selection 
in the main viewEZ window and click Views it will take you 
to the View Properties window. This window offers all the 
options you would find in the Domino Designer View 
Properties windows plus the formula options found in the 
Programmer's pane. But unlike Domino Designer, viewEZ 
lets you modify as many views as you want at the same time. 

2.�1 Mass-edit view properties and formulas in viewEZ 

1.�4 Ytria viewEZ lets you preview 
your changes in Lotus Notes

1.4 Preview your changes in Lotus Notes in  
no time: If you select some cells in either the Columns by 
Position in View or Columns by Link to Shared Column tabs 
you have access to the Generate Preview of Selected Views 
function. You can find this command in the Columns menu.

An example of a Notes view changed using viewEZ 

change from this.�.�.�
.�.�.� to this in a few clicks

2.2 Use existing views as templates: You can use 
any existing view or folder as a template for updating view/
folder properties. To do so, click the Populate Tab Using 
Another View or Folder button highlighted in figure 2.2; 
the resulting Select a Design dialog will list all the views and 
folders in your current database (you can also click the 
Open Database button to load another database for more 
choices of design elements). Once you've found a view or 
folder you'd like to use, just click the Select button and the 
‘template’ design's settings will be applied to the active 
View Properties tab.

2.�2 Select any design and use it as a template for view/
folder properties



1
Ytria actionBarEZ lets you scrutinize and 
modify action properties and formulas.� 
Here's how:

 

1.1 A bird's eye view of database actions: Just make a 
selection in the main actionBarEZ screen then click the Actions 
button and then the Actions window will appear. The Actions 
window shows all the actions associated with the selected 
design elements in a table. 

1.�1.�1 Cells equal actions: In the Actions window, each 
cell represents an action. The order in which the cells appear 
corresponds with their position in an action bar.Take control 

of your Notes 

actions and 

action bars.� Ytria actionBarEZ lets 

you completely overhaul the look and 

feel of your Notes applications' action 

bars in a few simple clicks

The selection tree in the main actionBarEZ window 

1.�1 Ytria actionBarEZ lets you quickly 
see and edit all the actions in all your 
design elements

Quick ST rT
g u i d e
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1.�1.�2 Headers equal design elements: Each 
column header in the Actions window represents a 
design element (eg views or folders).

1.�1.�3 Submenus stand out: In actionBarEZ, submenus 
are delineated by cells with diagonal stripes. 

1.�1.�4 Color schemes: Ytria actionBarEZ offers five 
color schemes; each scheme tags columns cells with 
different information about your database's actions. Use 
the following F-keys to cycle between color schemes:

> F5: Shared/Not Shared 

> F6: Action Type 

> F7: Show Menu/Bar 

> F8: Hide Notes/Web/Mobile 

> F9: Modified/Not Modified 

1.2 Change the way your actions work: If you 
select one or more cells in the Actions window and then 
double-click your left mouse button, actionBarEZ will open  
a window where you can modify action properties. The first 
three tabs are the same as the Action Properties window in 
Domino Designer. The fourth tab displays either System 
command; Simple action; Formula; LotusScript; JavaScript; 
or Web JavaScript depending on the action. This tab will 
not appear when multiple actions are selected.

1.3 Drag-and-drop or cut-and-paste actions: In 
the View by Position in Action Bar tab you can completely 
overhaul your action bars with a few clicks of the mouse. 
You can drag-and-drop an action to move it to another 
design element's action bar. You can also cut, copy, paste 
or delete actions in this tab.

Submenus in actionBarEZ 
1.�2a Double-click 
a selection in the 
actionBarEZ Actions 
window to change its 
functional properties

1.�2b You can modify 
multiple actions 
simultaneously in 
actionBarEZ

1.4 Create shared actions in single step: Just 
drag a cell to the Shared Action column (it's on the far left 
of the View by Position in Action Bar tab) and voilà—it 
becomes a shared action. 

1.5 See exactly where shared actions are 
being used: The View by Link to Shared Actions tab 
quickly tells you where a shared action is used. This is handy 
if you plan on deleting a shared action and want to be sure 
it's not in use. In this tab, actionBarEZ also flags duplicate 
shared action usage with a brown cell.

1.�5 See where actions are being shared in actionBarEZ 

Note: you can make non-contiguous selections by 
holding down the Ctrl key).

!
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2
Give your actions bars an instant 
makeover with actionBarEZ.� 
Here's how:

2.1 Mass-edit cosmetic aspects of your action 
bars: With actionBarEZ's Action Bars Window you'll have 
access to all the options in the Domino Designer Action Bar 
Properties box but with a big added bonus—you can apply 
these changes to many action bars at once. To do this, just 
make a selection in the main actionBarEZ window and click 
the Action Bars button. You can then make any desired 
changes in the Action Bars window. Your database will 
remain unchanged until you click the Apply button.

The Action Bars window in actionBarEZ

With actionBarEZ you can overhaul the 
look of many action bars simultaneously

2.2 Copy action bar properties from another 
database: If you click the Select a Design button in the 
Action Bars dialog, you can pick a design element in any 
database and actionBarEZ will populate the Action Bars 
window based on the settings of this design element. This 
feature is a great way to ensure that all your databases' 
action bars have a consistent look and feel. 

Ytria actionBarEZ lets you copy action bar 
properties from other databases



1
Ytria designPropEZ lets you instantly 
search for design element properties.� 
Here's how:

A]  Select some items in the selection tree  then click the 
Search button in the main designPropEZ window.

B]  In the Search Properties window, tick the checkboxes for 
properties you'd like to find. 

C]  Click Search in this window.

D]  Voilà—the design properties of the database will appear 
in the Search Results window. The Search Results 
window supports grouping (the gray header labeled ‘drag 
a column header here to group by that content’) to help 
you organize the information. You can also export the 
data in this window to a number of common file formats.

Search, audit and update design element 

properties in designPropEZ.�

 Note: In the Search Properties window designPropEZ 
will ignore a design property if its checkbox is marked 
with a green square.

!

The designPropEZ main screen

The designPropEZ Search Properties screen

Quick ST rT
g u i d e
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2
With designPropEZ you can audit all 
the design element properties in a 
database.� Here's how:

A]  Click the Audit button in the main designPropEZ 
window.

B]  In the resulting Audit Results window you can drag 
a column header (eg Inherit From) into the grouping 
area to organize the results of your audit. This is a 
quick way to see design element properties across an 
entire database. Data from this window can also be 
exported.

 Note: For more information on this feature  
see the Ytria Online Help Database:  
http://www.ytria.com/WebSiteHelp.nsf

!3
You can use designPropEZ to batch 
update design element properties.� 
Here's how:

A]  Click the Update button in the main designPropEZ 
window.

B]  In the resulting Update Properties window, tick off 
the checkboxes for the options you'd like enable. 
Click a checkbox until it is blank if you'd like to 
disable an option.

C]  Click Update. If you choose to apply the changes an 
Update Results will appear. You can export the data 
in this window.

The designPropEZ 
Audit screen

 Note: In the Update Properties window 
designPropEZ will ignore a design property if its 
checkbox is marked with a green square.

!

4
You can batch process across several 
databases with designPropEZ and 
LotusScript.� Here's how:

A]  Open your designPropEZ installer database (it will be 
called “designPropEZ.nsf” if you only downloaded 
the individual tool and it will be called “YtriaEZsuite.
nsf” if you downloaded the entire EZ Suite). The file 
is installed to your Notes directory by default.

B]  From the designPropEZ database view you can create, 
edit or launch Batch documents.
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